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WWEELLCCOOMMEE  TTOO  FFLL  SSTTUUDDIIOO  
 
This guide is meant to be a general introduction to FL Studio. Please press F1 while you are 
running the program for the detailed in-line manual.   
 
Lifetime free updates of the edition you own: Did you know that customers who bought FL 
Studio 2 (way back in 1999), would by now have received FL Studio 3, 4, 5, 6 and 7 absolutely 
free! Given a $199 for an ‘industry average’ update cost for music software, that’s about $1000 of 
free updates. Boxed owners can visit our online store and for the cost of a couple of Pizzas and a 
6 pack of drinks, get lifetime free updates too. If you purchased via internet download then you 
already have lifetime free updates thrown in…send us pizza! So how have we stayed in business 
for over 10 years? You will notice that we include a number of demo plugins in the program and 
we rely on happy customers purchasing these (DirectWave, Maximus, Poizone, Sytrus, Toxic III 
etc) and content. Our philosophy is that you should pay only for what you use, and never pay for 
bug-fixes (hello competitors?!). Visit http://www.image-line.com to see what we have on offer.    

Here are just a few of, the more than 1000's of cool features in FL Studio: 

- Recording: Audio (microphones, guitars, synths), automation (knob / mouse movements) 
and notes (polyphonic melodies) live, then edit the performance. 

- Easy hardware linking: Right-click on the FL interface control, select link and tweak the 
hardware controller knob, done.  

- Piano Roll: The most advanced piano-roll in the industry. Per-note slides for native FL 
Studio plugins. Complete suite of editing and creative composition tools. 

- Step sequencer: Fast and intuitive pattern-based sequencing perfect for percussion.  

- Edison wave editor/recorder: Record, analyze, edit and transform audio. With beat 
slicing. 

- Share: import/export .wav (wave), .mp3 (mpeg layer 3), .ogg (Ogg Vorbis), .mid (MIDI) 
files and more. 

- Fast: Of course there is the legendary FL Studio workflow, the fastest path from your 
brain to your speakers! 

 
 
 
 
 
 
 

Lemon Boy is in the house: Hey Dudes!  Having problems? Before you 
panic and start spamming the FL Studio Tech Support, look for me.  I'll pop 
up here and there with answers to common problems that might save you 
some trouble. Of course, don’t neglect to press F1 inside FL Studio to open 
the in-line help or visit the on-line forums http://forum.image-line.com/ .  
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IINNSSTTAALLLLAATTIIOONN  IINNSSTTRRUUCCTTIIOONNSS  
 
The installation procedure for FL Studio differs slightly, depending on whether you purchased the 
product online, or as a boxed version with a CD and this manual. Read below for what to do: 
 

A. If you bought your copy of FL Studio as a boxed version, follow these steps:   
 

1. Run the CD. Insert the install CD-ROM that comes with your box in your CD-ROM 
drive. If you have auto-run enabled, you will see the CD menu automatically appear. 
Otherwise, right-click your CD-ROM drive icon in Windows Explorer and select 
Autorun. 

2. Start the Installation. Select the FL Studio installation link. The installation window 
will appear. Follow the instructions on screen. 

3. Serial Number. During the installation you will be asked to enter a serial number. 
You can find it printed on your CD case or Manual. Write it down for further use and 
make a backup of this number. 

4. Register On-line. Once you’ve completed the installation successfully you can 
register online to gain access to the extra FL Studio website features and community. 
Go back to the CD-ROM menu (reload as described in step 1 if needed), and click on 
the link called “Click here to register to the FL Studio community” or go to this link 
http://register.flstudio.com/box. NOTE: Registration is insurance against lost CDs!  

 
B. If you bought your copy of FL Studio online, follow these steps:   
 

1. Download and Install the Demo. Download and install the demo version of FL 
Studio. It is recommended NOT to install over previous releases of FL Studio or 
Fruityloops. 

2. Apply for a Regcode. Go to http://my.flstudio.com and enter your username and 
password you received by e-mail after your purchase. Click the button below to your 
regcode to pop-up. 

3. Check your email.  The FL Studio team will send you an e-mail with a link. Make 
sure your email account can accept our emails (domain: e-officedirect.com). Please 
follow all instructions carefully.  

4. Run the Program. Restart FL Studio if it is running, to be able to save your projects. 

5. Bookmark the Web Site.  The FL Studio web site http://www.flstudio.com is an 
awesome resource. Check back regularly to see what's up. 
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6. Read this Guide.  As soon as you start FL Studio, you'll be confronted with strange 
dialog boxes and messages.  Proceed to the next section of this guide to find out what 
to do next. Also check the extensive on-line help that comes with FL Studio. 
 

In case of problems, please check our searchable Knowledge Base – 
(http://support.flstudio.com/knowledgebase/base.php) and our support forums 
(http://forum.image-line.com/index.php). In case of order or registration related support, please 
create a support ticket at our website http://support.flstudio.com.  

FFIIRRSSTT  RRUUNN  
OK, so you just finished the installation and started FL Studio. This section explains what you 
will see. 

1. The System Settings Screen. When you first run FL Studio, you may be faced with a dialog 
box like the one below (if not, press F10 to access it). Use the select boxes to choose your 
sound card and hardware controllers. At first, you may be looking at the MIDI screen, but 
for now the most important one is the Audio screen, accessed as shown below. 
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2. Select a Soundcard Driver from the list in the pull-down menu. Select an ASIO driver if 
possible (identified by the word 'ASIO' in the name), as they allow lower latencies with less 
CPU load compared to DirectSound drivers. If your soundcard does not 'natively' support 
ASIO, the ASIO4ALL generic ASIO driver http://asio4all.com may work for you. If you 
don't know which one to pick, just leave it as it is. If you experience sound problems later on, 
you can come back to this screen (by pressing F10) and experiment with other options. 

 

 

 

 

 

1. Click Here 2. Then Here 

The term 'Soundcard' is used very loosely, you may have a separate 
soundcard in your PC, a chip on your motherboard or it may be an 
external device connected by USB/FireWire etc. The soundcard is any 
device that makes the sound you hear from your PC speakers. The 
Soundcard Driver is the software interface between the Windows 
operating system and the soundcard. The driver tells FL Studio what 
inputs/outputs the soundcard has and what sample-rates it can support. 
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3. Buffer Length.  You don’t need to worry about most of the settings here yet but you 
definitely should know what the Buffer Length does. The Audio Buffer is a temporary store 
of audio data waiting to be sent to the soundcard. This allows FL Studio to even out 
momentary spikes in CPU load. If the Audio Buffer runs dry, because your CPU can't keep 
up, then your soundcard will make rude pop, click or glitch noises (a buffer underrun). It’s 
worth noting that underruns can ONLY occur in real-time playback, they will not happen in  
exported audio files. Making the buffer longer will reduce underruns but FL Studio may feel 
sluggish when working live. Use trial-and-error to find a buffer length that is short enough so 
FL Studio feels responsive but not so short that causes underruns. 10 ms (440 samples) is the 
point of diminishing returns for responsiveness and CPU load starts to ramp up steeply. For a 
standard DirectSound driver, the ‘Use Polling’ and ‘Use hardware buffer’ options may 
improve latencies for some operating systems (2 switches x 2 states = 4 combinations, try 
them all), expect buffer settings of 20-40 ms.  

4. The Main Screen.  After you’ve closed the System Settings window, you'll be looking at a 
screen similar to the one below. The FL Studio desktop is based on a number of windows, 
most of these are movable (with overlap), resizable, zoomable and switchable so if a window 
isn't visible retrieve it using the Shortcut toolbar (or the function keys as noted in brackets 
below). The three main windows involved in FL Studio music creation are - Channels (F6), 
the Mixer (F9) and the Playlist (F5). 
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Video Tutorials! A picture is worth 1000 words, so a video must 
be worth, like, BILLIONS…once you are registered pop over to the 
FL website and watch hours of cool video tutorials, this is really 
useful so I’ll SHOUT –  

http://tutorials.flstudio.com 
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MMAAKKEE  SSOOMMEE  NNOOIISSEE  
 
Press the Play Button (also note the button to the left is in SONG mode).  You'll hear the 
demo song. If this is not the first time you've run FL Studio, you'll have to reload this demo. Open 
the browser (F8) left-click on the ‘Projects’ folder and right-click on the  NewStuff.flp, then 

select ‘Open’ from the menu. You can also drag the FLP file onto the 
desktop to open it. FLP files are FL Studio Project files and save entire 
songs.   

HHEELLPP!!  
 
This guide is intended to get you up and running - it is not meant to be a reference manual for 
everything FL Studio can do (that’s what the internal Help system (F1) and/or the FL Studio 
Bible are for). Let’s consider the main FL Studio components, in brief -  
 
1. The Hint Bar. This is located on the Main Window just under the Menu Bar (top left in the 

picture on the previous page).  When you hover your mouse over any of the controls in FL 
Studio, this panel will display a short description of what that control does. The Hint Bar also 
shows you the Shortcut Key that will activate the same function.  This is displayed on the 
right. Pressing this shortcut key has the same effect as pressing the corresponding button. 

 

 
 
2. On-line Help.  FL Studio also comes with an extensive on-line help reference. Just use the 

Help Menu and select Contents. This help also features context-sensitivity – select a 
window and press F1 on your keyboard. The reference automatically displays the help you 
are looking for. You will notice three tabs CONTENTS (the help), INDEX and SEARCH. 
The latter two tabs can be searched for key-words, try it! 

 
3. Tutorial Loops.  Click File >Open and surf to the Tutorials directory.  These loops contain 

notes on how to do various things in FL Studio. 
 
4. The Website.  FL Studio has a massive web site at http://www.flstudio.com.  The site has a 

support section that includes a FAQ Knowledge Base, Discussion Forum, Online 
Tutorials, Video Tutorials, Song Exchange section and the Samplefusion samples site.  If 
you have questions, check the discussion forums to see if your questions have already been 
answered, or to post your own question. 

Hint Bar 
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GGEETTTTIINNGG  SSTTAARRTTEEDD  
 
The following section will guide you through some of the basic (and not so basic) features you 
will use to make music with FL studio. You should however spend some time with the in-line 
help file (press F1 inside FL Studio) and work through the Setup Wizard and Introduction to FL 
Studio sections. 
 
 
 
 
 
 
 
 
 
 
 

TTHHEE  CCHHAANNNNEELL  WWIINNDDOOWW  &&  SSTTEEPP  SSEEQQUUEENNCCEERR  
 
When you start FL Studio for the first time, you'll see the Channel window (see the “First Run” 
section). Channels are instruments that can send audio to any Mixer Track, or which may also be 
used to access Channel Settings or the Piano Roll. The Channel Window also contains the Step 
Sequencer, with a default grid pattern suited to triggering percussion samples. The Piano Roll 
(page 60) is better suited to more complex compositions. 
 
1. What are Channels for? Channels are laid out horizontally (see below) and each one 

contains a single sound. Each channel step sequencer has, by default, 16 steps.  If you're 
musically inclined, these steps represent 16th notes.  If not, think of each group of four steps 
as one beat, so 16 steps are the four beats of a basic drum loop. 

 

  
 
 

Steps 

A Channel 

Channel 
Name on 
button 

HEY! Don't skip that step.  This guide 
will work a lot better if you start at one 
end and work your way through to the 
other. 



      

  
12 

 
 
 

 
2. What Steps are For?  Clicking on a step lights it up and tells FL Studio to trigger the 

instrument loaded into that channel at that point in the bar/loop.  For instance, the 1st, 5th, 9th, 
and 13th steps in the DNC_Kick channel are lit up, telling FL Studio to play the kick drum 
sound four times during the loop (if you are thinking of groups of four steps as a single beat, 
FL Studio will play the sound at the start of each beat.)  Try changing the pattern of steps in 
the DNC_Kick channel. (If you need to turn a step off, right-click it.)  Once you've got the 
steps to light up like the picture below, press the play switch to hear what you've created. 

 

 
 
 
3. What are Patterns for? All the note data contained in the stack of instrument channels in the 

Channel Window is known as a 'pattern'. You can switch to a new pattern with the Transport 
Panel 'PAT' selector. When you do this, the note data visible in the current Pattern will 

change to reflect the selected pattern. To hear 
only that pattern (rather than the whole Playlist) 
make sure the button at the front of the 
Transport Panel is in ‘PAT’ mode. Patterns are 

used in the Playlist as either pattern blocks or pattern clips. 
 
4. Play with the Channel Controls. After you've set up the pattern, try playing with the 

Channel Controls on the left.  The two round knobs (wheels) control the volume and pan of 
a single channel, and the green light switches the channel on and off. Panning is like the 
balance control on your stereo; turning this knob moves the sound from left to right in the 
stereo field. To reset a wheel to its default position, right-click on it and select reset. 

 
5. Make Your Own Beat. Don't like the beat above?  Good, then its time to make your own 

beat! In the next sections, we'll teach you how to load in new samples, set up melodies, and 
change the sound of each channel (and even each step) using Plugin Effects. 

  
 

Channel 
Mute, Pan 
& Vol 
Controls 

Suggested 
Pattern 
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TTWWEEAAKKIINNGG  TTHHEE  CCHHAANNNNEELLSS  
 
In this section, we'll show you how to modify the sound of the samples in each sampler channel. 
FL Studio supports so much of this kind of tweaking that it's possible for two people to create 
loops that sound totally different using exactly the same samples (technically, each channel 
contains a Instrument, which could be sample-based or could be a synthesizer plugin). While 
there are dedicated samplers like FPC (percussion) & DirectWave (instruments), the single 
channel sampler is a versatile and useful tool.  
 

 
 
 
 
 

1. Load a New Sample. Check out the Browser.  One way to load samples is to use the 
Browser (that's the other window you see when you first opened FL Studio in the "First Run" 
section above.) This is a special browser for selecting and loading samples, loops and presets 
files.  To find the DNC_Kick sound, click on Packs, and then Dance. Left-clicking on a 
sample will play it, right clicking will open it into the selected channel, and you can also drag 
and drop into the Step Sequencer.  Select a channel by clicking on the green Channel 
Selector light to the right of the channel name as shown above. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wait! What's a "sample"? A sample is a recorded sound 
stored in a file.  Each channel in FL Studio, by default, uses a 
single sample, usually containing a single note (like a snare 
drum hit or a single bass note), but they can also contain 
entire beats or tunes.  Samples are usually ".wav" file types, 
but FL Studio supports ".mp3" and “.ogg” sound files too.

Lost the Browser? No problem.  The five 
big buttons on the tool bar shown below 
will open and close various windows for 
you, including the Browser & Step 
Sequencer.  (The will become clear in the 
fullness of time…) 
 

 

Click Here 

Then Here 

Then Here 



      

  
14 

 
 
 

 
 
 

2. Open the Channel Settings Window (left-click on a channel button).  OK, let's modify the 
kick drum sample.  Load the DNC Kick sound (shown below) and open the Channel 
Settings window for that channel by left-clicking on the name button. You can also change 
samples using the file icon to the left of the Sample Name window (as shown below) -  this 
will open a browser on the directory containing the file "DNC Kick.wav" as well as several 
other kick drum samples. As you click on them, FL Studio will automatically play the 
sounds. Try opening some of the other samples and listening to the effect a new kick drum 
has on the sound of the loop. 

 
 

 
  

 
 

Click 
Here 

Sample 
File Name Channel 

Selector 

Save!  If you’ve created a masterpiece and you want to 
keep it, don’t forget to save. There’s a cool ‘Save new 
version’ that will add a 1,2,3…etc on the end of the FLP 
name, so you can keep all your old versions. 
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3. Play with the Sample Effects. Ok, at this point the best advice is to start the loop, then play 
with the controls in the sample (SMP) panel of the Channel Settings Dialog and listen to the 
difference in sound.  Here's a short description of what some of them do. For more info see 
the on-line help.  

 
 
 
 
  
 
 

 

Can't hear the difference?  If you press a button or turn a knob 
and you can't hear any difference in the sound, try making the 
same change on another channel.  For example, sometimes a 
change that doesn't affect a kick drum much will make a huge 
difference to the sound of a snare.  If you still can't hear the 
difference, stop the loop from playing and listen the sounds 
separately by clicking on the wave view window.  You might be 
able to hear the effect better without the other instruments.

Vol, Pan: Volume and panning 
wheels that also appear on the 
main screen for each channel.  
Turning these will also makes 
the wheels on the main screen 
turn. 

Remove DC Offset: Use this 
option to fix “vertical” offset in 
the samples (see Wave View 
below). 
Reverse Polarity: "Flips" the 
waveform vertically.  
Normalize: Maximizes the 
sample volume without 
distortion.  
Fade Stereo: Creates a stereo 
fade from the left to the right 
channel of the sample.  
Reverse: Reverses the 
sample.  
Swap Stereo: Switches left 
and right channel of the 
sample. 

Wave View Window: 
Shows the shape of the 
sound sample. Click here to 
hear the sample with all the 
effects. Also a drag and 
drop window for loading 
samples. 

Fade In (IN): Applies a quick 
fade in to the sample (turn 
maximum to left to disable).  
Fade Out (OUT): Applies a 
quick fade out to the sample 
(turn maximum to left to 
disable).  
Pitch bend (POGO): Applies 
pitch bend to the sample. Useful 
with drum samples.  
Crossfade Loop (CRF): Allows 
you to crossfade the sample for 
the creation of smooth loop 
sections (turn maximum to left to 
disable).  
Trim Threshold (TRIM): FL 
Studio trims the silence at the 
end of the samples, as this frees 
up RAM and does not alter the 
resulting sound. This control 
allows you to raise the volume 
threshold below which FL Studio 
detects "silence". 
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4. Add Some Echo.  Open the DNC_Kick channel settings and click the FUNC tab to get the 
view shown below.  The controls in the top section (Echo delay / fat mode) can be used to set 
up a cool echo effect for a single instrument.  Start by turning up the FEED about a quarter of 
the way, and listen to what happens to the kick drum sound…  Try playing with the other 
controls to change the sound of the echo… You can also toggle between various echo and 
“fat” modes by clicking the title bar of the Echo Delay section (the default is Classic Echo). 
More on these different effects can be found in the on-line manual… 

  
 
         
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pan, Cut, and Res do the 
same job as on the sample 
panel, but the effects build up 
as the echo dies out.   
 
Pitch controls the pitch of the 
echo.  If you turn this wheel 
right, the echo will get higher as 
it dies out.

Feed: Echo volume 
(sets how quickly 
the echo dies out).  

Time: Controls the amount of 
time (in dots) between each 
echo.  Maximum delay time is 
16 dots.

Ping Pong: Makes 
the echo flip back 
and forth from left to 
right (sounds cool 
on headphones).  Ech: Number of times the 

instrument will echo before it 
stops.

Getting Echo Time Just Right: The "Time" control is 
fine-grained to get you just the exact echo you want.  
But if you want to echo on the beat, you will have to 
look at the Hint Bar while you turn the dial. If you want 
the echo every three dots, just turn the dial until the 
hint bar shows "3:00". 

Arpeggiator: This 
gets explained in 
the Generators 
section of this 
guide. 
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5. Play With the Instrument Settings.  Let's take a quick look at the INS panel before we 
move on (There's also stuff you should read about in the MISC, check the FL Help).  Click 
on the INS tab and you'll get to the Instrument Settings.  Here you can add Envelopes and 
LFO to your sample for the Volume, Pan, Cutoff, Resonance, and Pitch settings.  

 
 

 
 
 
6. What's an Envelope? An envelope causes a parameter to vary over the life of the sound. The 

most common application is a Volume Envelope, that makes the sound rise then fall in 
volume. You can also put an envelope on Pitch, Cutoff, and Resonance.  In terms of a volume 
envelope (VOL), The Delay (DEL) sets how much time passes before the envelope starts, 
Attack (ATT) is the fade-in speed, Hold (HOLD) sets how long the sound holds at full 
volume, and Decay (DEC), Sustain (SUS), and Release (REL) control how the sound fades 
away.  Play with the knobs and watch the graph change below them. 

7. What's LFO? LFO stands for Low Frequency Oscillation. It’s like an Envelope but repeats 
over and over while a note is playing. Most commonly they are used to makes a particular 
effect oscillate up and down over the duration of the sound.  The Amount (AMT) sets how 
much the effect oscillates, Speed (SPD) sets how quickly it oscillates, Delay (DEL) sets how 
much time passes before the oscillation starts, and Attack (ATT) sets how quickly the 
oscillation ramps up to it's full amount.  Play with the knobs and watch the graph change. 

Effect Selector 

Envelope 

LFO 

Set Natural (root) Note 

Indicator Light 
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8. How do I Use Them? Use the Effect Selector (see diagram above) to choose the effect, and 
then turn the knobs on either the Envelope or the LFO.  To turn the Envelope on and off for 
each effect, click on the Indicator Light.  To turn off the LFO, reset the Amount (AMT) to the 
middle (knob pointing straight up.) 

9. Why Can't I Hear the Effect?  If you're still on the Kick Drum it will be hard to hear any 
LFO effect, although the Envelope might make a difference.  These effects are more audible 
on longer samples.   

Now we're cookin' with gas! 
…or is your PC on fire? 



      

  
19 

 
 
 

TTWWEEAAKKIINNGG  NNOOTTEE  PPRROOPPEERRTTIIEESS  
 
By now you're familiar with many of the way FL Studio lets you tweak and shape your sounds.  
In this section, we'll show you how some of those effects can be applied to each step separately.  
We'll also show you how to program melodies. Note that if you have Fruityloops edition or 
higher then we strongly recommend that you use the Piano Roll instead of the step sequencer 
for melodic work (see page 60). 
 
1. The Graph Editor.  The easiest thing to understand here is probably the Graph Editor 

utility. First, select a channel to edit by clicking on the channel name, or by clicking on the 
green Channel Selector light to the right of the channel name. Next, press the graph editor 
button that pops up the editor as shown below.   

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Effect Selector.  Try clicking and dragging the Effect Selector under the graph to see what 

effects can be graph-edited. You will see Pan, Velocity (another name for Volume),  Filter 
cut, Filter res, Pitch, and Shift. Though some of these effects were discussed in the 
"Tweaking the Channels" section, the difference here is that you can also tweak the value of 
these effects for each step separately. Each bar on the graph sets the effect value for the single 
note above (or below) it.  

Graph Editor 
Button 

Graph Editor 

Effect Selector 

Channel 
Selector 
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3. Panning the Kick Drum.  Try setting the pan effect as shown below.  The pan graph centers 
in the middle.  You can set pan values by clicking inside the bar for each note at the desired 
level.  After you have set up the view shown below, you should hear the kick drum flipping 
back and forth from one speaker to the other.  This sounds really cool if you combine it with 
the 3-step echo you added in the previous section… 

 

 
 
4. Try the Velocity. You can get instruments to fade in and out over a pattern using the velocity 

graph. Try filling in all the steps, opening the Graph Editor on Velocity then make some 
variations like those shown below (left-click and drag up/down on the bars). When you press 
play (in pattern mode) you will hear the volume ramping with each step. This graph does not 
center in the middle like pan, but goes from zero (bottom) to maximum (top). Volume slides 
like this can sound extra cool when combined with Cutoff and Resonance slides. Hint: to 
make a smooth line in the graph editor, right-click on the first bar, then drag the mouse to the 
right to set the values of all the bars at once. 
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5. Play with the Other Effects.  Try to get a feel for the other effects on the graph editor.  
Filter Cut and Filter Res can be used to add or subtract values to the main cutoff and 
resonance wheels in the INS panel of the channel settings dialog box. (See the "Tweaking the 
Channels" section.) Pitch makes the sample higher or lower, like the pitch wheel in the 
channel settings dialog box. Shift can be used to push a step closer to the step beside it (you 
more musical types can use this to groove a beat). 

 
6. Make melodies. Generally the Piano Roll is the best place for composing melodies (right-

click on a channel button), however if you have a melodic instrument loaded (such as the 
‘3OSC’ instrument) the Keyboard Editor can also be used. To load ‘3OSC’, right-click on an 
instrument button and use the ‘replace’ command from the popup menu. To edit notes in the 
melody, click the Keyboard Editor button with the 3OSC channel selected as shown below. 
What you see now is a vertical piano keyboard for each step on the screen.  Hopefully, you 
have some keyboard skills. (If not, it's time for some lessons!) You can change each note by 
left-clicking one of the buttons on the keyboard. Right-click turns the note off. When the 
loop is not playing, clicking a note will also play that note. But again, the Piano-roll is better 
for serious melodic work. 

 

 
 
 

 
 

Keyboard 
Editor Button 

Keyboard 
Editor 

Channel 
Selector 
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7. Super Important Tip. When you want to make a melody from longer samples, you often 
need to set it up so that each note cuts off the previous one. This easiest way to do this is by 
right-clicking the Channel Name in the Step Sequencer and selecting Cut Itself from the 
popup menu.  Notice that the Ins_Round channel has this option selected.  Try deselecting it, 
but be warned - the results can be nasty! 

 
 

 

Big News!  You can undo the last 
tweak from the Edit Menu or with 
CTRL Z. 
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TTHHEE  PPLLAAYYLLIISSTT  ((ffrroomm  PPaatttteerrnnss  ttoo  SSoonnggss))  
 
Now you've seen the basics of what can be done with sampled sounds in a single pattern. In this 
section we'll show you how to program more than one pattern and link them together into a 
longer loop.   
 
1. The Pattern Selector.  FL Studio lets you create 999 different patterns. In the previous 

sections, we've just been working with pattern 1, but we can access the other patterns by 
changing the number in the Pattern Number box. Use your mouse to drag in the Pattern 
Selector or use numeric ‘1’ till ‘9’ or  ‘+’ and ‘-‘). You’ll find these controls somewhere on 
the tool bar at the top of the main FL Studio window. Right-click the pattern selector to show 
all patterns with data in them.  

 

 
 
 
                         
 
2. Check out the Playlist. This screen can be opened either using the button under the hint bar,  

by hitting F5, or by right-clicking the song/pat button on the main screen (see above). Try it, 
and you should get a new window that looks something like the one shown below. This 
window is similar to the pattern view, except that the steps operate on whole patterns rather 
than single channels, and the bar lengths here vary to reflect the pattern length. Make sure 
Song is selected and press Play. You should see the Play Indicator on the Playlist start to 
move, and hear the patterns it is playing (use the NewStuff.flp). When the indicator reaches 
the end of the steps, it will jump back to the Song loop point and continue playing. Try 
moving the loop point (right-click where you want it to go) and see what happens. (If you 
press the Pat button, FL Studio will just repeatedly play the current pattern in the Step 
Sequencer.) 

Groovy. 

Pattern  
number box 

Pattern/Song  
mode selector

Play position indicator
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3. Up or down? The Playlist has an upper and lower area. These can be swapped with the menu 
options in the Playlist, but we will assume your Clip Tracks are above the Block tracks (as 
shown above). Clip tracks are a feature in FL Studio (Producer edition only). We have done 
something weird so pay attention! A pattern can be placed in either a clip track OR block 
track. In the example above we placed each pattern in BOTH the clip and block tracks, just so 
you can see where to put the patterns, but you only need to use one or the other for the pattern 
to play.  

  
4. What's the Point? Now you can assemble a number of patterns together to make a song.  

This lets you alter melodies, change beats, insert fills, and reuse some of the early parts of the 
song later.  The clip tracks show more information about the data patterns & clips contain. 
The blocks are more minimalist. It’s up to you how you want to work. Many composers use a 
separate block of patterns for drums, bass, lead, etc. so they can work on them separately at 
first, and then piece the song together in the Playlist. A good way to see the Playlist used 
‘full-on’ is to see the NewStuff.flp or flp’s in the ‘Cool Stuff’ folder in the browser. 

 
 
 
 
 
 
 

Play Indicator Song Loop Point Bar 4 

Pattern 1 
Clip (upper) 
Block (lower) 
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5. Data types: Each Clip track (upper region) can hold unlimited number of Automation clips, 
Pattern clips and Audio clips. To add a new instance of a clip just click in an empty place 
inside the tracks. Try moving the waves or cutting them with the slice tool. You can find 
more tutorial projects explaining how to use them and also plenty of information in the on-
line help (focus FL Studio and press F1). See more info in the chapter Audio Tracks. You can 
apply automation envelopes (e.g. to fade in/out an audio clip) on top of these audio clips. 

I get it! There’s note, sample and 
automation data and this can be laid out 
as Blocks (lower) or Clips (upper) 
Playlist…easy…I  think… what was that 
again?!  
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IINNSSTTRRUUMMEENNTTSS  ((ffrroomm  ssaammpplleess  ttoo  ssyynntthhss))  
 
Until now we've only been playing with Sample Channels.  But FL Studio also supports channels 
that contain sounds made in real time by software synthesizers like Sytrus, Wasp, SimSynth Live 
e.t.c..  To use the proper terminology, every Channel contains an Instrument (also more generally 
called a ‘generator’), which could either be a sample, a synthesizer plugin, or some other type of 
instrument in combination with the effects in the Channel Settings dialog. The combination of these 
Instruments with the sample channels gives FL Studio a major sonic boost!   
 
1. Adding a Synthesizer Channel. To add a channel containing a synthesizer Instrument, click 

on Channels > Add One as shown below and select one of the many instruments available, 
such as Audio Clips, Automation Clips, 3xOsc, BeepMap, BooBass, Buzz Generator 
Adapter, Chrome, Dashboard, DirectWave, FL Keys, FL Slayer, FPC, Fruit Kick, Fruity 
DrumSynth Live, Fruity DX10, Fruity SoundFont Player, Sytrus, Plucked!, SimSynth, 
Wasp and many others (the list of instruments is growing with each release!).   
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2. What to Expect. The new channel will appear in the Step Sequencer and the Instrument's 

Configuration Screen will appear.  If the Configuration Screen is small, it will appear inside 
a Channel Settings window (3xOsc, BeepMap, Fruit Kick, Fruity SoundFont Player, 
Plucked!).  Otherwise, it will appear as a standalone window (BooBass, Buzz Generator, 
FPC, Fruity DrumSynth Live, Fruity DX10, SimSynth Live, Wasp, Sytrus, Poizone, 
ToxicIII).     

 
3. How Do I Use them? It's important to know that most Instruments have their own help 

available.  If the Configuration Screen for the Instrument is embedded in a Channel Settings 
window, click on the channel name.  If it's in a standalone window, click on the corner of the 
dialog.  

 
 

           
 

 
4. Preset Sounds.  Many of the synthesizer instruments (BeepMap, Buzz Generator, Fruit Kick, 

Fruity DrumSynth Live, Fruity DX10, SimSynth Live, Wasp,…) have preset sounds 
available.  In most cases, you can get to them from the Presets section of the menu shown 
above, or by clicking on the little arrows in the top right (see picture above). 

5. Channel Settings.  All these instruments have a Channel Settings window that you get by 
clicking on the Channel Name, just like for Sample Instrument Channels.   
But since each instrument is different, they may not all have the same panels as the Sample 
Instruments do.  For instance, the TS404 has the SMP, MISC, and FUNC panels, while the 
BeepMap instrument has INS, MISC, and FUNC. 

6. What do these Instruments Do?  OK, here's the skinny on some of the Instruments. Please 
note that some of these Instruments need to be purchased separately. If you haven’t bought 
them, you’ll only have the demo version of the Instrument that will allow you to listen to its 

Preset Sounds

Help 
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sounds, but these channels will not be saved in your FL Studio project. Some demo 
instruments (and effects) may make a soft hissing sound every so often. If you can hear 
something that sounds like the ocean, you probably have a demo loaded somewhere in 
your project. 

a. 3xOsc. This is a plain instrument that allows you to mix three Oscillators, each of which 
generates a tone.  The sounds on their own are not exciting, but they are good raw 
material to be combined with INS panel effects and other plugin effects (explained in a 
later chapter) and it’s a great place to start if you are new to synthesis. 

 

 
 

b. BeepMap.  This is a weird one.  Takes a bitmap image file and turns it into a sound, with 
strange and wonderful results. This is the same kind of synth that Aphex Twin used to 
embed an image of himself in a track that shows up when the track is put through a 
spectrum analyzer. 

 

c. BooBass. A handy little bass instrument from the guy who brought you SimSynth. 
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d. Chrome. A visualization plugin that allows you to trigger graphical events using the 
Piano roll, Hardware controller or Automation clips. Includes a camera, scene selector 
and a large variety of different scene parameters. 

 
 

e. Dashboard. Allows you to create your own MIDI and Internal Controller interfaces 
(check the on-line help to see what internal controllers are about). 

 

 
 

f. FL Keys. A realistic piano simulator with optimized CPU and memory usage. 
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g. DirectWave. A powerful sampler featuring a fully programmable synthesis section, with 
all the usual sampler goodies. DirectWave can also 'sample' (record sound) when loaded 
into a mixer track on an effect slot. 
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h. FL Slayer. A realistic electric guitar simulator equipped with a quality amp section and 
effects rack enabling you to recreate the complete electric guitar sound without additional 
plugins. 

 

 
i. FPC (FL Pad Controller). A software plugin similar to the hardware Akai MPC unit, 

coded & optimized for the FL Studio platform. FPC is a self-contained multi-
layer/velocity drum machine that makes it easy to create, edit and swap drum kits on the 
fly. FPC supports 16 multi-layered patches for banks A and B. 

 

 
 
 

j. Fruit Kick. A kick drum instrument. 
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k. Fruity DrumSynth Live. A Drum Synthesizer plugin that lets you define drum hits and 
control them via a keyboard.  

 
 

l. Fruity DX10. An 8-voice polyphonic (that means 8 notes at once) FM Synthesizer. This 
one’s designed to give high quality sounds without eating up too much CPU. 

 

 
 

m. Fruity Envelope Controller. Allows you to trigger envelopes that may be linked to 
parameters in FL Studio. Includes an envelope editor, similar to that used in Sytrus and 
FPC. 
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n. Fruity Granulizer. This one helps you get cool, choppy sounds out of your samples, like 
when the “Funk Soul Bruvva” sample slows down in Fatboy Slim’s “Rockefeller Skank”. 

 
 

o. Morphine.  A powerful Additive Synthesizer with a logical, flexible architecture that 
allows you to create any sound. You can do this directly by adjusting harmonics 
manually or by taking any input sample and resynthesizing it into one of 4 independent 
voices. 
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p. Toxic III. Features a hybrid synthesis engine, combining the best of FM and Subtractive 
synthesis. With warm, analog-modeled filters and set of built-in effects, Toxic is 
convenience, simplicity, and superb sound quality. 

 

 
 

q. Fruity Keyboard Controller. An automation control which makes no sound of its own, 
but can be used to control knob and sliders within FL Studio, by mapping note pitch and 
velocity from the Piano roll or Step sequencer to any automatable parameter or third-
party plugin. 
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r. Fruity Slicer. This one lets you slice up a beat and then play back individual drum hits 

using the keyboard. You can make cool breaks really quickly with this tool. (More on 
how this works in the BeatSlicer section below.) 

 
s. Fruity SoundFont Player. An advanced sample instrument that works with the 

SoundFont2 collection. 

 
t. Fruity Vibrator. You can add vibes to your songs using any Force Feedback (.ffe) file. 

These files can be created using Microsoft Force Editor tool in the DirectX Developer 
SDK. 
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u. Poizone. A subtractive software synthesizer designed to bring you professional quality 

results, without a learning curve that hinders your creativity. The concept behind PoiZone 
was to design a synthesizer that had the smallest number of controls while providing the 
maximum flexibility and features 

 

 
 

v. Plucked! A synthesizer that produces specialized stringed instrument sounds like guitars, 
harps, mandolins, etc. 

 
 

w. SimSynth Live. A fully functional digital synthesizer.  Use this baby to create phat-
sounding analog sounds for your dance and trance tracks. 
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x. SynthMaker. Hang onto your hats! SynthMaker is an audio programming application 
that is used to create virtual instruments and effects without the need to write basic code. 
The instruments and effects you create in SynthMaker can be used in FL Studio as 
'native' plugins and shared with other SynthMaker users 

 

 
 

 
y. Sytrus. Sytrus the most versatile synthesizer in the FL Studio armory, combining 

Frequency Modulation (FM), Ring Modulation (RM), plucked string modeling and 



      

  
38 

 
 
 

subtracting synthesis, and featuring a powerful envelope editor. The synth includes a 
powerful editable unison mode and a comprehensive effects section. 
 

 
 

z. TS404.  Is a great ‘techno’ machine for creating synth lines and bass lines, which sound 
similar to the classic TB-303 machine (look under ‘more’ in the Add one pop-up). 

 
aa. Wasp. Another full digital synthesizer. This one creates fast, buzzing, techno-oriented 
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sounds (hence the name). 

 
 

bb. WaveTraveller. Create realistic scratches with a full control over the smallest details! 
 

 
                          

cc. Layer. This isn’t really a Instrument, but it’s cool. It lets you create a master channel to 
control a bunch of other channels at once. 

 
dd. MIDI Out. This one isn’t a Instrument either. It lets you send a MIDI controller signal to 

an external (or internal) MIDI device. 
 

 



      

  
40 

 
 
 

ee. Speech Synthesizer.  This is a wizard to add synthesized speech lines to your song (see 
p.39). 

ff. Others. There are also quite a few other instruments, see the FL Studio Help (F1). 
 

7. Even More Instruments! With the Fruity Wrapper you can now add any VST or DX plugin 
synthesizer you download or buy. From the Channels menu select Add One > More. This 
will produce a list of the available plugins as shown below. You can select any of the plugins 
under the Fruity Generator Plugins heading by double-clicking them.  The “F” in the box 
beside the plugin name marks it as a “Favorite” and will make it appear directly in the Add 
One menu shown below. 

 

 
 

 
8. VST and DX Plugins. You may have noticed the Fruity Wrapper in the above list of 

plugins. The wrapper is not strictly an instrument but provides the interface between FL 
Studio and VST or DXi plugins.  If you double-click on an But you don’t need to open it on 
its own – if you double-click on one of the VST Plugins, it will automatically open the 
Wrapper for you. You may notice that some plugin instruments (and effects) don’t have their 
own interface, see the DX10 freeware plugin below. This uses the generic ‘wrapper’ 
interface. Others have a more professional looking interface, like Poizone.  
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9. The Other VST Plugins. I know what you’re thinking – what about all the other VST 

Plugins in the list? VST plugins are either synthesizers or effects (FX), and most of the ones 
you have to start with are FX (we explain how to 
use the FX in the Mixing & Effects section below). 
Unfortunately, there is just no reliable way for FL 
Studio to tell the difference between FX and synth 
plugins, so you’ll just have to remember which is 
which.  If you try to open a VST Plugin and all you 
get is an error message and the empty wrapper 
shown below, then it was probably an FX plugin. 

 
10. Do I have to register? Some of these products are made by FL Studio partners, so yes in 

some cases you do have to register them to unlock their full capabilities.  Go to 

DX10, generic interface. 

Toxic III, custom interface. 
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http://www.flstudio.com for more information on where to send your hard-earned cash. 
 
11. Where Can I Get More? There are literally hundreds of synth plugins out there to 

download.  Some of them are free, and some you have to pay for.  Search the web and 
http://www.flstudio.com or http://www.image-line.com for good deals.  A place you should 
definitely bookmark is http://www.kvraudio.com - a huge sites with every VST plugin you 
could possibly want (new VST Plugins should go in the shared Program Files\Image-Line\ 
VST directory on your hard drive). 

 
12. The Arpeggiator. Now that we've introduced the Synth instruments, we can finally tell you 

what the Arpeggiator section in the Channel Settings window is for.  Open one of the synth 
channels (SimSynth Live, for instance) and go to the FUNC panel of the channel settings 
box.  Now click the up arrow and select a chord.  Now go to a new pattern and place a 
single SimSynth note and press play.  Instead of a single note, you get a repeating arpeggio.  
Cool, huh?  Read more about this in the on-line help. 

 

 
 
 
 
 
 

Direction of 
Arpeggio 

Chord Selection 

Octave Range 
and Repeat 

Speed, 
Duration, etc. 

Don't deny yourself, dude!  You need all these generators. Save up 
your squeegee money and buy them ASAP. Probably the one that will 
make the most difference to your tracks is Sytrus and while we are on 
the topic, don’t forget Maximus, this Maximizer plugin rocks! 
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13. Speech!  Yep, you read that right. You can have a conversation with FL Studio using the 
built in support for speech synthesis.  The easiest way to access this feature is to look under 
“speech” in the sample browser, and drag one of the files there onto the step sequencer. 
You’ll get a dialog that looks like the one below. All you have to do is replace the text, 
choose a personality, style, rate (speed), and pitch. Click the “listen” button to hear what it 
will sound like. When you’re done, press the check mark and a sampler channel will be 
added. You can also drag a speech file into a Granulizer, Fruity Scratcher, or Fruity Slicer 
channel. Have fun. 

 

    
 
 

 
You might have to spell some words funny to make it sound 
ok… Also, you can make it sing by putting the number of 
semitones you want the pitch to rise on each word in 
brackets after it. Try typing “all your(2) base(3) are(2) 
beelong to us” in the dialog above (use a monotone style.) 
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MMIIXXIINNGG  &&  EEFFFFEECCTTSS    
IMPORTANT: This guide is a general Getting Started guide for all existing FL Studio Editions. 
Some features however, are not available in some editions. E.g. the FL Studio Fruityloops 
Edition doesn’t have the Track Adjustments sliders capabilities. Please check our site 
http://www.flstudio.com  for upgrade conditions. 

One great feature of FL Studio Producer Edition is Mixer window. From here you can mix more 
than 64 tracks and make links between mixer tracks to create complex mixing chains. Take a 
deep breath!  

One of the best features of the mixer is that you can add effects to the sounds coming from the 
channels. Effects can range from a simple volume changes to more advanced effects such as 
chorus, reverb, phaser, delay, flange, and EQ, among others (you can also add instruments, 
notebooks, controllers, monitors and all kinds of other goodies!).  
 
Open the Mixer Window.  Bring up the Mixer screen by pressing F9 or by going to View > 
Mixer. You'll get a window like the one below… 
 

 
 

What are you looking at?  Along the left are the mixer Tracks. You have one Master Track (M 
in the header), 64 Regular Tracks, 4 dedicated Send Tracks and 1 Selected Track, although 
any mixer track can act as a send. The edge of the mixer may be selected and dragged to show up 
to 64 mixer tracks at once or there is a slider in the top left corner of the mixer to scroll across the 
tracks. The Master Track is selected by default (although in the picture above track 1 is selected 
as shown by the lighter color). Each track has room for eight FX Plugins (to the right above). 
When you change the selected track (by clicking on it) the FX bank and Track adjustments will 
change to show the settings for that track.  
 

Mixer 
tracks 

FX Plugin 
slots 

Track 
controls 

Send  
knobs 

Master 
track 
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The Track Adjustments panels show the properties for each track. The volume and stereo balance 
settings are the linked to the corresponding knobs below each track. Some of the other things on 
the track adjustments panel are an equalizer, stereo width knob and a sound level meter (shows 
the output volume of the track). 
 
Turn Plugins On and Off / Mixing Wet and Dry.  Click on the green LED next to each plugin 
slot to turn it on and off.  Try this with the loop running to hear the difference. You can also 
tweak the knob next to the LED to mix a “dry” (without effect) and “wet” (with the effect) sound. 
 
Select Plugins. If you want to add new plugins, click on the arrow where you want to add the 
plugin and then choose from the Favorites List or choose Select to choose from the entire list 
and configure your favorites. 
 

 
 
Tweak the Plugins.  Right-click the plugin to open and close its Plugin Settings screen.  Some 
plugins have a plain interface like the Fruity Fast Dist shown below.  Others have fancier 
looking controls.  Most plugins come with their own help as shown below, so we won't go into 
how to use the controls here.  But for now, why not play with them to see what they do? 

1. Click here 

2. Then here 3. Then select 
from here. 
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Sending Sound to the mixer. The box in the top right of the Channel Settings (below) is a Mixer 
track ‘send’. Any effects placed in the Master Mixer Track will be applied to all the sounds in the 
song.  But effects in Mixer Tracks 1-64 will only be applied to the Samples and Synths, which 
have selected that Mixer Track in their Channel Settings Dialog.   
 

 
 

 
What are the Send Tracks For? Economy! There are 4 special Send Tracks that take their input 
from other Mixer tracks, rather than from Instrument Channels. Suppose you want to put the 
same Fruity Reverb on Guitar and Drums, but you want to add Fruity Delay to the guitar and EQ 
to the drums. Easy. Send the drums to Regular Mixer track 2 where you put the EQ. Send the 
guitar to Regular Mixer track 3 where you put the Fruity Delay. Then put the Reverb in Send 
Track 1 and turn the Send 1 knob on Mixer tracks 2 and 3 to send the output of these tracks to 
Send Track 1.  Now you have the same reverb applied to both guitar and drums, but you only had 
to use a single reverb plugin.  The send knobs are placed beneath the track receiving the input 
not the track sending. An orange down-arrow shows the source track. 

Left-click here 
to open the FX 

Click Here for help 

Sending to  
Mixer track 2 

Effects have presets too! 

Click here to enable / 
disable FX 
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Changing Plugin Order.  The order in which you add effects plugins decided in what order the 
FX are applied to the signal. Think of it this way – the signal enters the top of the FX stack and 
leaves the bottom. So Delay above a reverb would mean the delay sits in a wash of reverb. 
Reverb above delay means the reverb tail is chopped up and delayed. To make it easier to 
experiment with effects order, FL Studio has a simple function to move an effect up or down in 
the effects chain. A quick way is to place your mouse cursor over the FX slot and scroll your 
mouse wheel. No wheel? Click the FX menu and press ‘u’ or ‘d’ on your keyboard to move 
the selected FX. 
 

 
 
What do the Plugins Do?  As mentioned, you can get on-line help for all of the FL Studio 
Plugins, but here's a quick rundown on what they all do -  
 

This source track is 
sending audio to 2 
other tracks.  

These two tracks receive input, note the knob positions that show the input 
signal volume, click on the up-arrow to make send knobs appear/disappear. 

Dedicated 
‘Send’ tracks. 

Place your mouse 
over the FX name 
and scroll the wheel 
OR Left-click and 
press ‘u’ or ‘d’ 
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Buzz Effect Adapter. Lets you load in any Buzz Machine effect. FL Studio comes with a 
few installed already, but you can get more at http://www.BuzzMachines.com. 
 
Edison. A fully integrated audio editing and recording tool. Edison loads into an effect slot 
(in any mixer track) and will then record or play audio from that position (see page 067 for 
more info). 
 
EQUO. Is a bank of 8 Graphic Equalizers with between-bank morphing, particularly suited to 
automation. 
 
Fruity 7 Band EQ. Equalizes your sound (just like on your Dad's stereo at home.) 
 
Fruity Balance. Lets you change the pan and volume while live recording. 
 
Fruity Bass Boost. Boost that bass for a super-phat sound. 
 
Fruity Big Clock. Pops up a huge timer to tell you how long the song’s been playing. 
 
Fruity Blood Overdrive. Use this to distort channels. 
 
Fruity Center. Use for real time DC offset removal. 
 
Fruity Chorus. Adds a smooth chorus effect. 
 
Fruity Compressor.  Use this to flatten out the dynamics of the sound. Apparently, Fatboy 
Slim uses massive compression to get his drums to sound the way they do… 
 
Fruity dB Meter. Pops up a big levels meter. 
 
Fruity Delay. Use for a true echo (not just repeated samples like the channel echo).  
 
Fruity Delay 2. The next generation Fruity Delay. Adds panning and other effects. 
 
Fruity Delay Bank.  Consists of a bank of 8 identical banks, each is able to be feed to the 
next bank in the chain in order to create complex delay and filtering effects.   
 
Fruity Fast LP. Use for low pass filtering that's CPU friendly (cutoff and resonance). 
 
Fruity Fast Dist. A great little distortion effect that uses almost no CPU.  
 
Fruity Filter. More cutoff and resonance filtering that’s not so CPU friendly. 
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Fruity Flanger. If you have to ask, you haven't heard it yet.  Real popular among guitar 
players, this LFO-type effect can add a cool feel to any song. 
 
Fruity Flangus. A very useful effect, which allows you to enrich the stereo panorama of your 
instruments, add high quality chorus and simulate unison synthesis. 
 
Fruity Formula Controller. This is a fancy internal controller that you can link to other 
wheels and sliders inside FL Studio.  Wait until the Live Recording section for more info...  
 
Fruity Free Filter. Yet another filter - a classical 12db instead of a state variable filter like 
the Fruity Filter (whatever the hell that means.)  
 
Fruity HTML Notebook. Add some notes to your loop in html format, or add your own web 
page!  
 
Fruity Love Philter. The most powerful filter plugin in FL Studio. Consists of 8 identical 
filter units, each able to be feed to the next one in the chain. Creates complex delay, gating 
and filtering effects. 
 
Fruity LSD. Enables FL Studio to access the DirectMusic Software Synthesizer bundled 
with DirectX 8. Note that you must have DirectX 8.0 or later installed on your machine. The 
LSD acts like an external MIDI device, which can be controlled from a MIDI Out Generator 
Channel (see section on Instruments above). 
 
Fruity Limiter. Single band Maximizer, Compressor & Limiter.  
 
Maximus Multiband Maximizer. 3 band compressor limiter. Powerful maximization 
(DEMO only). 
 
Fruity Multiband Compressor. A 3-band stereo compressor using ButterWorth IIR or 
LinearPhase FIR filters to separate the incoming signal into three bands for processing. 
Limiter functionality is also included. 
 
Fruity Mute 2. Use this to mute (silence) channels while live recording. 
 
Fruity Notebook. Keep your song notes here!  This is the plugin used in the Tutorial Loops 
that came with your package. 
 
Fruity PanOMatic. Useful for panning the sound back and forth smoothly.  
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Fruity Parametric EQ. A parametric equalizer built for FL Studio. Regular equalizers only 
let you set the levels for preset frequency bands, but with a parametric equalizer you choose 
the frequency bands to equalize.  
 
Fruity Parametric EQ 2. An advanced 7-band parametric equalizer plugin with spectral 
analysis. The frequency and width of each band is adjustable, along with the band type. 
Useful for when you need precise control over EQ.  
 
Fruity Peak Controller. This is another internal controller. More on controllers in the Live 
Recording section below.  
 
Fruity Phase Inverter. Use to reverse the stereo phase (left and right). 
 
Fruity Phaser. Like the Flanger, but even cooler. 
 
Fruity Reeverb. Use for a much nicer reverb than you can get on the Channel Settings 
dialog. 
 
Fruity Reverb 2. New and improved Reverb plugin with higher quality sound and more 
controls than the original reverb.  
 
Fruity Scratcher. Load up a sample and scratch the hell out of it. This plugin is actually 
more like a instrument, since it produces sound on its own rather than modifying a channel. 
 
Fruity Send. Place this plugin between two other plugins to split the signal and send it to one 
of the four  Send FX channels.  
 
Fruity Soft Clipper. This is a CPU friendly soft limiter filter. It allows you to avoid clipping 
and distortion by applying soft compression to the input signal. 
 
Fruity Spectroman. Pops up a spectrum analyzer so you can view the spectral distribution of 
the sounds in your track. 
 
Fruity Squeeze. Is a bit reducing, distortion and filtering plugin. Fruity Squeeze will add a 
gritty tonal character to input sounds and is particularly effective when applied to drum loops. 
 
Fruity Stereo Enhancer. Adds some really nice stereo separation and other effects. 
 
Fruity Vocoder. An advanced vocoder with a wide range of adjustable parameters and zero 
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latency (i.e. the vocoded sounds are not “late”). This effect uses quite a lot of CPU with 
slower machines but has unique precision and features. 
 
Fruity WaveShaper. Is a wave distortion effect which maps input to output values using 
flexible spline-based graph. 
 
Fruity X-Y Controller. Yet another internal controller you’ll learn more about in the Live 
Recording section below. 
 

Preset Effects. If a plugin has built in presets you can access them through the presets section of 
the effects menu as seen above, or by using the little arrows like with the synthesizer plugins. 
You can create your own presets by clicking save preset.  When you do this, FL Studio saves the 
positions of all the plugin controls so that you can get that exact sound back again later.  If you 
save your presets in the directory FL Studio suggests, then it will appear on the menu under 
presets. 
 
Getting New Plugins. We gave you a great selection of FX Plugins with your FL Studio 
Package.  But people are always creating new ones, and you can find many of them on the web.  
Some are free and some cost money.  Surf the web to see what you can find! The on-line 
reference (press F1 in FL Studio) contains in-depth step-by-step guides on how to install and use 
such third party plugins. 
 
CPU Considerations. "Woh! I can use as many plugins as I want?!?" Actually, no you can’t. 
Each plugin you use takes up a certain amount of your computers power. Some take more power 
than others. The number of plugins you can use before your computer starts grinding and running 
out of breath depends directly on your CPU speed (you know, that GHz thing) and also somewhat 
on the amount of memory you have. There is no formula for how many plugins you can use, but 
if the sound starts breaking up after you add a plugin, it’s a good sign that you’ve gone a few 
plugins too far.  Don't forget about the Send Channels, though.  They can help you cut down on 
the total number of plugins. Also don’t forget that adjusting the Buffer Length can often solve 
your CPU problems (see the “What are You Lookin’ At?” section). 
 
 

+ me… me… me… ∗ 
∗ me… me… me… +  
∗ meeee…me! 
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  RREECCOORRDDIINNGG  LLIIVVEE  KKNNOOBB  MMOOVVEEMMEENNTTSS  ((AAuuttoommaattiioonn))
 
Open the Channel Settings for an instrument, and click on the INS tab.  Did you know you can 
record any movements you make to any knob?  It’s called ‘Automation’ and it's the key to 
making your songs come alive… 
 

 
 

 
1. Choose an Automation Pattern.  OK, this is important.  Automation is easily misplaced so 

it’s good to record all it into a single pattern, that’s why we have one pre-named ‘Main 
automation’ in the Playlist. You need to place that pattern in the Playlist at the beginning of 
the song to play back the live tweaking.  As you learn more about what you are doing, you 
can break out of this mold, but you need to start simply. 

 
 

 
 
 
 
 

Click the INS Tab 

Watch this 
knob move! 

Remember to select the right 
Pattern AND have the Automation 
recording mode ON! (right-click the 
record button and tick).  
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2. Record Some Live Tweaking.  The easiest thing to do is create a new flp (File > New), lay 

down some drum loops and practice playing with the channel PAN and VOL knobs of the 
snare (for example).  When you think you've got something groovy, make sure you've 
selected the Main Automation pattern and have selected Automation recording in the 
right-click menu on the record button, then press the Record Switch shown below.  You may 
hear a three-tick countdown first, depending on whether the 321-countdown light is on. Then 
start the song and work your magic.  The song will play once and then stop.  Turn recording 
off and press Play. You've just done your first Live Recording session! 

 
                                       
 

 
 
3. Set the Buffer Length low.  If you noticed a delay between tweaking knobs and FL Studio's 

response you may need to lower your buffer settings (hit F10 and select the Audio tab).  The 
lower you set this slider, the faster FL Studio will respond.  But don't set it too low, or the 
sound may get choppy (see the "What are You Lookin' At?" section). 

4. Important Note. When you've got the Recording Switch on and the loop is playing, moving 
a wheel will erase over all the previously recorded tweaks from that point in the song until the 
end.  This can be frustrating, so often it's best to get the recording approximately the way you 
want it and then make further changes in the Event Editor described in the next section. 

5. What can be Recorded? Most wheels and sliders are recordable, including those that control 
Plugins.  But some controls aren't recordable.  The quickest way to tell what's recordable is to 
mouse over a control and look for the red steps in the Hint Bar.  If these steps appear, then 
you can record that control. 

6. Where is my data? All automation is recorded into the currently selected pattern. To see it, 
in context, place the pattern clip in the track area, the display will show a mini-graph. 

 
 
 

 

Song Mode plays from Playlist Record Switch 

Red Dots Description 

Plugins.  You can do live tweaking recording on most 
Plugins, but not all of them. Experiment to find out. 

Intro count in 
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LemonBoy's Live Tweaking Recording Advice…
 
1. Always, always, always check the pattern selector before you start 
recording. Automation will be recorded into the selected pattern. 
 
2. Right-click on the record button to check Automation is ticked. 
 
3. Get your song laid out the way you want it before you start live recording.  
Once you have events recorded, it is difficult to change the layout of the 
playlist in a way that will still sound good. 
 
4. Always save a backup copy of your loop before you start any live 
recording.  That way if you mess things up or change your mind, you can 
go back to the clean copy. 
 
5. Save your loop frequently during live recording.  If you accidentally tweak 
something and erase some events, you can always go back to the previous 
version. 
 
6. Get yourself an External Hardware controller to make your life easier 
(See the section on External Controllers for more info!) 
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TTHHEE  EEVVEENNTT  EEDDIITTOORR    
Unless you're a real pro, you'll probably find that the live automation doesn’t always sound  
perfect.  That's where the event editor comes in.  Each time you move a wheel during a recording 
session, the new setting is stored as an "event" for that wheel at that moment in the loop.  With 
the event editor, you have complete control over how the sound is tweaked during playback. 
NOTE:  You will find an option under the Edit Menu to convert Event data to Automation Clips. 
 
1. Record Some Live Tweaking on a Particular Knob.  The PAN on the Snare sample, for 

instance.  Let's assume you already did that in the previous section.   
 
2. Stop FL Studio and Open the Event Editor.  Right-click on the knob you automated, and 

select Edit Events from the pop-up menu.  The screen you are looking at now is a lot like the 
Graph Editor described earlier.  One difference is that this graph controls the level of a single 
wheel or slider at a particular point in the song.  (OK, it's actually more complicated than that.  
Remember how we told you to keep all your live recording in a single pattern (Pattern 2) and 
place this pattern once at the beginning of a song?  If you do that, then the bars in the Event 
Editor will match the bars in the Playlist.  If you don't do that, you're on your own!) The other 
main difference is that this graph is used to set Events (bright vertical lines corresponding to 
the value of the wheel you are setting) that persist until the next event.  

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit mode 
selection Edit menu Play indicator 

Events   
(Each sets the level until 
the next event) 

Vertical/ 
Horizontal 
zoom  
(click + drag)  
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3. Event Editor Modes. The event editor has several modes, which are explained below. 
 

a. Draw Mode.  In this mode, the mouse pointer looks like a pencil .  You can add new 
single events by left clicking in the main window.  You can also left-click and drag to 
draw multiple events, or right-click and drag to draw a line of events. 
 

b. Brush Mode.  This mode ( ) is very similar to Draw mode, but ignores snap distance 
the mouse. 

 

c. Delete Mode.  Click on the delete symbol  to change to this mode.  You can delete 
events by clicking on them, or click and drag to delete a series of events (the events are 
the bright vertical lines on the main window.) 

 

d. Smooth Mode.  Click on the smoothing (interpolation) symbol  to change to this 
mode. You can click and drag to highlight a region. When you let go of the mouse button, 
the events will be smoothed out, instead of looking choppy. Try it! You can also turn on 
Auto-Smoothing from the edit menu, so that events you draw in Draw Mode are 
automatically smoothed out. 

 

e. Select Mode.  Click on the select symbol  to change to this mode.  When you click 
and drag, you will see a red region highlighted on the Play Indicator Bar. You can also 
right-click on the Play Indicator Bar in any mode to expand the highlighted region. You 
can cut and zoom to this region from the Edit Menu. 

 

f. Zoom Mode. The zoom mode -  allows you to select an area in the event editor an 
automatically zoom fit to that area. 

 
4. Miscellaneous Facts.  Here's some stuff you should know about the Event Editor. 
 

a. Undo. There is a limited form of undo available for the Event Editor.  Use CTRL-Z to 
undo the last action. 

 
b. Setting the Initial Event. You will notice that after live recording, the wheel you 

recorded sometimes doesn't start in a sensible place when you play back the loop.  This 
can be fixed by turning the wheel to a good start position, and then right clicking the 
wheel and selecting Init Events With This Position. This sets the very first event so that 
the wheel will always start where you want it. 

 
c. Getting a Feel for It. It takes some practice to master the event editor, and to be able to 

get a song to sound exactly the way you want it, but it's definitely worth it.  Keep 
practicing until you get it right! 
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d. Live Recording Defeats Static Tweaking.  If a wheel has some events recorded on it, 
you can no longer just set it anywhere you want and expect it to stay there.  You have to 
go through the Event Editor or start a new live recording session to change it. 

 
5. Introducing the Event LFO. Earlier on, we explained how to use the LFO (Low Frequency 

Oscillation) controls on TS404 channels (it's also available for Sample Channels on the INS 
panel).  But it's sometimes hard to control exactly how this oscillation is going to fit with the 
song.  That problem is solved with the Event LFO, which lets you simulate the perfect 
oscillation inside the event editor.   

 
6. Using the Event LFO. Open the event editor for some control.  Make sure you're on the right 

pattern in the pattern selector.  Now select an area to oscillate using Select Mode or by right-
clicking on the Play Indicator Bar.  Now hit ctrl-l or select LFO from the Tools Menu.  This 
will pop up the LFO Settings window and immediately apply the LFO to the selected area.  
See below for an example. 

 
 

  
 
 
7. Play with the Main LFO Settings.  Notice the dialog has three sections.  If you play with 

the controls in the Start and Shape sections, you should be able to create all kinds of cool 
effects.  In the Start section, you can alter the value (height), range (depth), and speed 
(length) of the waves.  In the Shape section you can alter the shape of the wave (sine wave, 
saw-tooth, or square) and the phase (basically moves the waves left and right.)  
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8. What About the End Section?  If you want to make the LFO change as it progresses, turn 

on the End section by pressing the red button.  Once the light is on, you can modify the 
parameters for the beginning (left) and end (right) of the LFO, and FL Studio will smoothly 
morph the settings from start to end.  This lets you create really cool changing LFO effects 
like below.  In the picture, a square wave LFO starts at bar 2 and ends at bar 4.  As the LFO 
progresses, the speed increases and the value and range decrease from their Start to their End 
values. 

 
 

                         
 
 
 
 
 
 
 
 

horizontal position 
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9. What is in the Edit Menu?  In the Edit Menu you can delete all events (Edit > Delete All), 

select all events (Edit > Select All), and change the color and look of the editor (Settings).  
You can also turn Snap on and off. Snapping automatically aligns things you are moving 
around in the Playlist or Piano Roll, for example, so placement is always right on a beat or 
bar.  The Snap resolution can be changed on the main toolbar (see below).  Try the different 
settings to see how it effects highlighting and event placement. The finest grain is Tick, 
which will cause you to snap to extremely fine-grained locations between notes.  If you select 
Auto, then FL Studio will decide for you where the best snap location is. Note that there are 
local snap settings for the Event Editor, Playlist  and Piano Roll so you can have different 
values in each place.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
  
  
  
  
  
  

Time for more tips
  
* The SNAP shown above is the ‘global’ snap, there is a local snap 
for the Event Editor, Piano Roll and the Play List so these may be 
set independently. 
  
* You can undo an LFO with Ctrl-Z.

Global snap 
resolution. 
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TTHHEE  PPIIAANNOO  RROOLLLL  ((NNootteess))    
  
You may have already realized that there are some things that the Step Sequencer doesn't do very 
well.  It gets tricky to use when you have melodies that are longer than 1 bar.  It's also tricky if 
you want to use a single-note sample to play chords.  Finally, it's nice to be able to slide notes like 
on the TS404, but you can't do that with any other type of channel.  The Piano Roll solves all of 
those problems! 
 
1. Open the Piano Roll.  Load up NewStuff.flp and select a pattern that shows some green bars 

as shown below.  Notice that the Step Sequencer view is very different.  These channels 
contain Piano Roll data instead of normal steps.  You can open the Piano Roll for any, 
channel either by right-clicking the channel name or by left-clicking the Mini Piano Roll.  
Open it for the Ins_Round channel. 

 
 

 
 

2. What You're Looking At.  First thing to notice is that this screen looks a little like the Event 
Editor.  See the Play Indicator Bar, the Edit Mode Buttons, and the Edit Menu Button?  
But the "events" in the Piano Roll are notes to be played at the given location, rather than 
level settings for various FL Studio controls.  Each horizontal green line shows where a note 
should start and end, and the Piano Keyboard on the left shows the pitch of each note.  The 
note labeled below is a C5 (C in the 5th octave), which will start on the second beat of the first 

Left Click Here 
(Mini Piano Roll) 

Right Click Here 
(Channel Name) 
 
Then Here 
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bar and play for 3/4 of a beat.  
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3. What Kinds of Channels Can Have Piano Rolls?  You can have a Piano Roll for any type 
of Instrument.  But there's something you should know about Sample Channels.  You can 
use the Piano Roll on any Sample Channel, great for percussion programming, but chords and 
sustained notes will always work best when you are using Looped Samples.  Loop points 
that let the sample play over and over again to create a sustained sound that lasts as long as 
the note is held (length of the green bars above).  If you don't have a looped sample, you can 
still use the Piano Roll, but remember your notes may not last as long as you wanted them to. 

 
 
 
 
 
 
 

 
 

Edit Menu Edit Mode  
Buttons 

Play 
Indicator 

Note 
C5  

Zoom 

Display 
Mode 

Local 
Snap 

Velocity 
(volume) 
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4. Basic Piano Roll Editing -    
 

a. Entering Notes. To enter a note, make sure you're in Draw Mode by clicking the Draw 
Mode Button (see the Event Editor section) or the Paint Mode Button, click on the note 
area, where you want it to start. Then grab the end of the note and stretch it to the length 
you want. If the loop is not playing, you should hear the note you are entering as you drag 
it around. The length of the note will match the length of the last note you placed.  To 
change the length, grab the right hand side of the green bar and drag it.   

 
b. Note Snap.  You may find the note snaps to a place you didn't want it to go.  If so, 

change the Snap Level on the main toolbar the same way as you did for the Event Editor 
(see previous section).  Sometimes you just can't get the note length to snap where you 
want no matter what you do.  In this case, hold the ALT key to override snap and drag the 
note (smooth!).  

 
c. Note Color. See the row of 4 colored buttons under the Edit Mode Buttons?  These let 

you select the color of the notes you enter.  This may seem foolish right now, but color-
coding can really help you out when you're trying to make sense of the notes you entered.  
Plus, the Edit Menu lets you Select By Color so you can Delete or Copy and Paste only 

Using Loop 
Points 

Loop 
Points 

Man, this thing 
just keeps 
gettin' better! 
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those notes. 
d. Deleting Notes.  Two options here - either right click the note you want to delete or go 

into Delete mode with the Delete Mode Button (see the Event Editor Section). 
 

e. Undoing Changes. Like the Event Editor, there is a limited undo available from the Edit 
Menu or by pressing Ctrl-Z. 

 
f. Cutting, Copying and Pasting Notes.  Go into Select Mode with the Select Mode 

Button (see Event Editor section) and click and drag to highlight some notes.  Then use 
the Cut, Copy and Paste options in the Edit Menu or use Ctrl-C, Ctrl-X, and Ctrl-V.  
Pasting can get a little tricky, though.  The notes will paste to their identical locations in 
the first bar that is currently displayed on the screen.  So to paste from bar 1 to bar 2, 
select the notes in bar 1 and hit Ctrl-C to copy, then scroll over to bar 2 and hit Ctrl-V.  If 
the notes don't appear, they probably went into bar 1.  Press Ctrl-Z to undo and try again. 

 
5. Chords and Harmonies.  One of the really nice features of the Piano Roll is that you can 

have notes sound on top of each other to create chords and harmonies.  Here, we're getting 
into sophisticated stuff that you need some kind of musical intuition for, but FL Studio does 
make life a little easier by giving you a Chord option on the Edit Menu.  Select the type of 
chord you want, and then go into Draw Mode.  You can now drop entire chords onto the 
canvas.   

 

           
 
 

 

Overlapping 
Notes 
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6. Pitch-Bending Notes.  This is really cool, but only works for FL Studio native plugins such 
as Sytrus (to pitch bend VST instruments you can automate the pitch knob for the Channel 
it’s loaded into).  If you click on the Slide Icon in the top left just under the Edit Menu 
Button, you can insert pitch-bending notes (also called Slide Notes).  To see how this feature 
works, place a long note on the canvas, and then place a slide note above or below it.  Make 
sure the two notes overlap.  The long note will play until it reaches the slide portion.  Then 
the pitch will rise towards the Slide Note and stay there until it reaches the end of the original 
note. The longer the Slide Note, the longer the slide. 

 

 
 

7. Tweaking the Notes.  Remember the Graph Editor from way back in the Step Sequencer 
section?  It let you individually change Volume, Cutoff, Resonance and so on for each note.  
The Piano Roll has a similar function, laid out in the bottom part of the Piano Roll Editor.  
Every time you enter a note, you get a spike in the bottom graph that shows the level of the 
parameter selected by the drop down box on the left (labeled Event Select above).  After you 
enter the notes, you can change the values of any of the parameters by grabbing the top of the 
spikes and dragging them. You can set Velocity, Pan, Cutoff, Resonance, and Pitch.  As an 
added bonus, you can also use this graph as the Event Editor for Channel Pan, Pitch, and 
Volume.  NOTE: You can also change a note’s properties by double-clicking it. 

 
8. Importing MIDI Tunes.  In the File Menu under MIDI, you'll find two methods of 

importing MIDI sound files directly into the Piano Roll Editor. There are tons of MIDI files 
for various popular melodies floating around out there.  Now you can suck them directly into 
FL Studio and use them in your songs.  How cool is that? 

Slide 
Icon 

Note 
Starts 
 
Slides  
Up 
 
Slides 
Down 
 
Then 
Stops 

Event 
Select 
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AAUUDDIIOO,,  PPAATTTTEERRNN  &&  AAUUTTOOMMAATTIIOONN  CCLLIIPPSS    
 
IMPORTANT: This guide is a general Getting Started guide for all existing FL Studio Editions. Some 
features however, are not available in some editions. The FL Studio Fruityloops Edition doesn’t have 
Audio Track or the Integrated Wave Editor capabilities. Please check our site http://www.flstudio.com  for 
upgrade conditions. 
 
FL Studio Producer Edition lets you work with Audio, Pattern and Automation clips. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
The top section of the Playlist can contain the audio, note and automation data.  
The tracks on which these clips are placed are not fussy, you can place any type of clip anywhere, 
you can even overlap them. The ‘track’ area is a great place to arrange and edit your song. It is 
also possible to cut and split any of the clip type in multiple pieces and rearrange the pieces, and 
it’s all non-destructive, cool! 
 
Each clip in the tracks view will have a channel instrument associated with it. Audio clips: are a 
special version of the Sampler channels. Automation clips: are a dedicated internal controller 
plugin and Pattern clips are pattern data.  
 
Each automation/audio clip channel you add in the Step Sequencer becomes available in the 

Audio , 
Automation, 
Pattern  
Switches 

Musical notes Sound/Sample

Control 

Blocks can contain 
notes & automation 
too! 

Don’t miss 
these 
menus, left-
click the 
down-
arrows. 
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tracks view and vice versa - dropping samples on the audio tracks generates an Audio Clip 
channel (unless a channel exists with the same sample). The audio tracks provide you with an 
 
easy visual way to arrange a set of large audio clips, while seeing the waveform preview inside 
the tracks. You can cut and split the audio clips in multiple pieces and arrange the pieces 
independently on the audio tracks. 
 
To place an audio clip, switch to draw or paint mode and left-click in an audio track (if no Audio 
Clip channels exist, you will see a dialog where you can browse for a sample to be used).  
Paint mode allows you to draw multiple instances of the audio clip at once (hold the mouse 
button and drag). 
 
To erase an audio clip, click it with your right mouse button or use the left mouse button in 
erase mode. 
 
To switch an audio clip instance to play another Audio Clip channel, open the clip menu (left-
click the arrow in the top left corner of the clip) and from the Select Channel menu, pick an 
Audio Clip channel to switch to. 
 
To open the Channel Settings of the channel associated with the audio clip instance, open the 
clip menu and select Channel Settings. 
 
From the clip menu, select Preview to listen to the audio clip sample (hit the Stop button in the 
Transport panel to stop the preview). 
 
Automation clips can automate any editable parameter over the complete song (instead of event  based 
automation). A common use of these automation clips is to make a fade-in/out for an audio clip by 
automating its volume. However, the use of automation clips has a much bigger scope than controlling the 
clips volume. Feel free to experiment with its use. Use the appropriate switch to switch between Audio 
clips, Automation clips and Pattern clips handling. 
 
 

AAUUDDIIOO  RREECCOORRDDIINNGG    
 
What about Audio recording? You will need FL Studio Producer edition or higher and to be 
using an ASIO soundcard driver to record audio directly into FL Studio. It’s a huge (but 
rewarding) area that is carefully covered in the on-line manual. Press F1 in FL Studio and click 
on the Contents section ‘Recording Audio, Notes & Automation’, then the ‘Audio Recording’ 
page.    
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EEDDIISSOONN  WWAAVVEE  EEDDIITTOORR  //  RREECCOORRDDEERR      
 
IMPORTANT: This guide is a general Getting Started guide for all existing FL Studio Editions. 
Some features however, are not available in some editions. The FL Studio Fruityloops Edition 
doesn’t have Audio Track or the Integrated Wave Editor capabilities. Please check our site 
http://www.flstudio.com  for upgrade conditions. 
 
Edison is a fully integrated audio editor and mixer-track recorder. Edison loads into an effect slot 
(in any mixer track) and will then record or play audio from that position. You may load as many 
instances of Edison as you require in any number of Mixer Tracks or Effects slots. To open 
Edison, press Ctrl+E in a Sampler Channel, or load from the effects menu into mixer track/s.  
 
Many powerful tool are available within Edison. Brief descriptions of some tools, and how to 
open them are provided below. 
 

 
 
The Edison Amp Tool works in a similar way to the mixer track controls, including stereo 
separation, panning, linked and independent L and R channel volume. To open the tool, press 
Alt+A inside Edison, or use the Tools>Amp>Amp option. 
 
The Convolution Reverb engine in Edison works by multiplying two audio signals in the 
frequency domain as a sort of 'moving average'. A reverb effect is obtained when an 'impulse' file 
is convolved with the original wave file. Reverb impulse files are created by recording short, 
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sharp sounds in real spaces or through a reverb/effects unit. The recorded sound is then an 
acoustic fingerprint of the reverberant space. This technique is equivalent to sampling an 
instrument and is very powerful, allowing you to 'borrow' impulses from very expensive 
hardware or real spaces you would never have the chance to record in. A convolution reverb will 
sound identical to the original space or hardware (with the particular settings used). Of course, the 
internet is brimming with free impulses for your downloading pleasure (see 'Impulse Resources' 
below).  

To open the dialog you can either left-click on the Convolution Reverb button , press Ctrl+R 
inside Edison, or use the Tools > Spectral > Convolution Reverb option. Once an impulse is 
loaded you can perform any of Edison's editing functions in the spectral preview window. Right-
click on the spectral preview to open the editing options. 

 
 

The Edison Blur Tool works in a similar way to the Convolution Reverb, by multiplying an 
impulse sound (in this case, noise), against the waveform. The impulse function is cross-
multiplied with the source in a moving average, to smear or 'blur' the sound. The multiplier 
function is determined by a user-selectable envelope. To preserve more of the original qualities of 
the sound, use narrower shaped envelopes. 
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The Equalize Tool boosts or cuts frequencies according to a user defined EQ envelope. The 
example below shows the effect of the selected EQ curve on a white noise sample. Frequency is 
displayed on the horizontal axis, time on the vertical axis (sample start is at the top, sample end is 
at the bottom) while intensity/saturation of color represents frequency amplitude.  

To open the tool you can either left-click on the EQ Tool button  , press Ctrl+E inside Edison, 
or use the Tools > Spectral > EQ option. 
 

 
 

The Time Stretch / Pitch Shift tool allows you to alter the duration, pitch and formant of a 
sample independently. Edison and, more generally the Sampler Channels & Slicer tool, use the 
élastique Pro, zplane algorithms to deliver advanced time stretching / pitch shifting that meets the 
standards of professional production and broadcast applications.  

To open the tool you can either left-click on the Time Tool button , press Alt+T inside 
Edison, or use the Tools > Time > Time stretch / Pitch shift option. To open the paste-stretch 
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dialog press Ctrl+Alt+V or use the Tools > Edit > Paste stretch option. The paste-stretch dialog is 
available only after a sample selection cut or copy operation. 

The Edison Loop Tuner allows you to remove clicks, pops or beating sounds from a loop. The 
Loop Tuner is not an automatic loop finding tool, it is intended for smoothing loops that have 
already been selected. Be aware that to accommodate the loop smoothing process, some settings 
will move the loop-start point automatically. To preserve your loop-start point, set the Crossfade 
and Snap settings to minimum. 
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Beat slicing. Edison has a range of beat slicing and drum stretch tools (Tools > Time > 
Drum(loop) stretch) that will allow you to create your own sliced beats.  
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SSHHAARRIINNGG  YYOOUURR  WWOORRKK  
So now you’re done with your song – you probably want to bring it out of FL Studio so you can 
put it on a CD, post it on the Internet, or edit it in another program. The Export function exists 
for this purpose. Here's how to use it. 
 
1. Export to Wav,  Ogg or MP3. This option is available from the Main File menu. Whether 

you choose Wav, Ogg or MP3, you will be asked to specify the name of the file and then the 
dialog below will appear.  There's a lot to choose from here, and we don’t have space to go 
into detail.  If you want an explanation of every button, go to the on-line help F1, it's all there.   

 

 
 
2. Should I Use Wav, Ogg or Mp3?  Wav is a raw sound file format.  Huge files, excellent 

sound quality (expect to use about 10 MB per minute depending on  Bit Depth).  44.1 kHz, 
16 bit Wav files are for burning onto CD.  MP3/Ogg are compressed formats with smaller 
files, but sound quality may be compromised (expect to use about 1 MB per minute 

Dude!  That looks 
complicated… 
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depending on Bit Rate).  If you want to share files on the Internet, MP3/Ogg are good. 

3. Should I Use "Background Rendering?"  Rendering can take a long time and hogs the 
CPU, especially if you choose the high-quality options (as shown) in the Quality section of 
the window above.  But if you click on Background Rendering, FL Studio will minimize and 
continue to render unobtrusively in the background.  It takes longer…but the internet has 
plenty to see while you wait. 

4. Exporting to a Zipped Loop Package.  This feature is useful if you want to transmit your 
FL Studio files over the web. It takes your FL Studio file, plus all the samples used in that 
files, and puts them into one zip file.  

5. Project Bones and Project Data Files. These options let you save a lot of the information 
about your track. The Project Bones option saves a file with all your presets, automation 
information, and so on to be loaded later. Project Data Files saves all the samples and other 
raw data you used to a single location on your hard drive. 

6. Where Can I Put My Songs? There are a number of places on the web where artists can 
place their music in MP3 format for free.  http://www.mp3.com is probably the best-known 
site, but it's easy for an amateur looper to get buried there in all the high-profile commercial 
stuff.  http://sectionz.com is an option if you are more interested in feedback from other 
musicians who use FL Studio. The site is a musical community with people like you 
reviewing every song that is placed on the site. It's a great way to get feedback.  If you don't 
like either of these options, you can always create your own site using one of the many free 
hosting services out there.  Good luck! 

7. Collab? When you register your box version at our website http://www.flstudio.com (or 
when you ordered your version from our FL Studio website), you’ll get a personal unique 
username & password to access the user restricted area’s on our site. But it will also allow 
you to use our online COLLAB (stands for collaboration) utility.  This program allows you 
to chat with other FL Studio users, collaborate with them and share your songs online on our 
Collab Internet servers.  

 
 
 
 
 
 
 
 
 
 

  
 

If you want to share your work to the big public, 
consider setting up your own website! 
 
Try EZGenerator Web Site Builder  (read easy 
generator), the tool we use to setup and 
maintain our own websites  
 
This is another piece of high quality software 
developed by Image Line Software!  
 
Free Trial version at: 
http://www.ezgenerator.com 
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EEXXTTEERRNNAALL  CCOONNTTRROOLLLLEERRSS  
 
Did you know that you already have at least two ‘external controllers’ attached to your PC? One 
is your typing-keyboard and the other is your mouse.  Obviously these don’t make sounds, but 
send control signals to your PC so you can type and move your mouse. Similarly, external 
USB/MIDI controllers are just devices to send control signals to your PC, however in this case 
they are designed to play like a piano keyboard, move like a mixer desk, turntable deck or any 
other piece of hardware that is used to make/mix music. With a controller attached you can move 
the  knobs and switches in FL Studio, or play a plugin instrument like a synthesizer. The only 
catch is that as the controller isn’t hard-wired to particular functions, you have to tell FL Studio 
ahead of time what you want each knob on the controller to do (this is just the same as assigning 
your typing-keyboard control-keys in a game for example, a minor inconvenience for the luxury 
of changing both cutoff and resonance at the same time!)  Each knob on the controller can be 
linked to a different wheel or slider on FL Studio.  If you have a controller, this section will tell 
you how to make it work with FL Studio.  If you don't have one, get one, if you aren’t sure where 
to start consider a small 2 octave MIDI keyboard with some knobs, you won’t regret it!  First 
we'll introduce a few of the more popular controllers, and then we'll tell you how to set them up. 
 
1. A Few Examples of Controllers.     

 
Oxygen 8 – This is a nice example of a combined musical keyboard and knob controller. It 
provides 2 octaves of notes, 8 assignable knobs that can be linked to knobs and sliders in FL, 
has transport controls to start/stop FL Studio and is connected to your PC over USB. Easy!  

 

 

I think I need some 
Oxygen!!! 
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Evolution U-Control.  Alternatively the U-Control has only knobs and sliders. 24 knobs and 
9 sliders makes for a lot of  control. Again this is connected to your PC by USB. Too easy! 

  

                     
       
 

Other Controllers.  -  If you are serious then the sky is the limit, the Keystation Pro-88 has 
more control action than you are ever likely to need. Similarly if you already have other 
MIDI hardware, like the AKAI MPC (shown below) then that can be used to control FL 
Studio too (the MPC is the perfect match for our FPC plugin!)  

 
 

  
 
 
 
 
 
 
 
 

Whoa! Talk about 
bringing a gun to a 
knife fight! Are you 
sure this thing can’t 
make any sounds of 
its own?  

Legendary AKAI MPC + FPC  = Bliss ☺ 
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2. Setting Up Your Controller.    
 

a. Connect your controller to your PC (USB or MIDI).  MIDI connectors are an older 
format and a bit more complex than USB so we will spend some time on them - Look on 
the back of your computer.  If you see two or three round, 5-pin connectors labeled 
"MIDI", then you're in business.  If not, look for a 15-pin trapezoidal joystick port.  If 
you have the round connectors, you need a cable to go from "MIDI Out" on your 
controller to "MIDI In" on your computer.  If you only have a game controller 
connection, you'll need a special cable that has two round MIDI plugs at one end and a 
trapezoidal plug at the other.  Both these types of cables should be available at any music 
store specializing in keyboards and synthesizers (but if you ask for them in a computer 
store, you may just get blank looks.) 

 
b. Turn on the Controller and Start Up FL Studio. Press F10 to open the system settings. 

Then if you have an Oxygen 8 or U-Control just select ‘Generic Controller’ in the 
controller type.  Try turning the knobs on your controller.  If everything is ok, you should 
see a little red "Midi" light flash beside the Hint Bar of FL Studio every time you turn a 
knob.  If that works, great!  You can skip steps c to e.  If not, read on my friend. 

 

1. Click here 

2. Then here & 
Select generic. 
 

3. Then here 
 
4. And here 
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c. Check the Options menu to see if there is a check mark beside Enable MIDI Remote 
Control. If not, click on it and see if you get the light now.  If not, read on. 

 
 
 

 
           hERETIC 

 
 

d. Set Your MIDI Input Device.  If the light is still not coming on when you turn knobs on 
your controller, go into MIDI Settings (from the Options menu or by hitting F10).  
Check out the Remote Control Input box.  If you see the word "none" there, then you've 
got to select an input.  Typically, you will be presented with a number of choices, and 
you'll just have to try them all to figure out which one is right. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Customer: Yo, check it out. I need a 
keyboard controller for FL Studio.   
 
Computer Store Guy:  QWERTY or 
DVORAK?

The Little 
Red? 
Light 

Are you 
ready to 
rock?  
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e. Troubleshooting Checklist.  If the red light is still not coming on when you turn the 
knobs on your controller, here's a list of things you should check. 

 
* Did you select the correct controller type in step b? 
* Did you enable "Enable MIDI Remote Control" in step c? 
* Did you select the correct MIDI input in step d? 
* Is your USB controller detected OR are your MIDI In and Out cables reversed? 
* Did you plug the controller into a power outlet? 

 
The fun part - Linking a knob to Your Controller:   
 

a. Right-click on the Control You Want to Link to the hardware controller.  In this 
case, we're trying the main volume control on a sampler Channel.  Now right-click on 
the knob and select Link to controller, to pop up the Remote controlling settings 
window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b. Turn a Knob on Your Controller.  You should see the Remote controlling settings 
window disappear and the Channel Volume knob should now move in response to your 
hardware knob movements.  You're in business! 

 
c. Set the Buffer Length as Low as You Can.  Earlier, we explained the buffer length 

slider (get to it by hitting F10 and clicking the Audio tab).  This slider determines the 
delay time between you turning a knob and the sound of FL Studio changing.  So you 
want to set it low.  But if you set it too low, the sound will become choppy.  So try to find 
a happy medium.  If you can't get it low enough to do what you want, then I guess you 
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need a faster computer. Sorry, dude. 
3. Which Controls Can I Link? Pretty much all of them, actually.  For reference, though, it's 

the same set of controls that can be changed in Live Recording.  Again, if you want to know 
whether a control can be linked externally and live recorded, mouse over it and look for the 
two red steps in the Hint Bar.   

 
4. What About Internal Controllers? Finally, we can tell you about the Internal Controller 

Plugins listed in the Effects section (the Formula Controller, Peak Controller, and X-Y 
Controller). These are plugins with controllers, which can set other controls. Did you follow 
that? Let’s take the Fruity X-Y Controller as an example. Open the plugins window (F9) and 
put a Fruity X-Y Controller on the master Mixer track. 

 
 

 
 
 

 
a. The Fruity X-Y Controller lets you control two wheels at once by linking one wheel to its 

X (horizontal) dimension and one wheel to its Y (vertical) dimension. Then you can grab 
the circle in the main window and as you pull it around, it changes both controls that it is 
linked to.  It’s particularly handy for controlling cutoff and resonance at the same time. 
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b. Link the Cutoff wheel to the X value of the internal controller, as shown above. Now link 
the Resonance wheel to the Y value. Then open up the Fruity X-Y Controller window, 
start the loop, and drag the circle around to listen to the Cutoff and Resonance changing 
at the same time. Cool, huh?  

 

 
  
 

Well, that’s it. Have fun! Don’t forget 
there’s more help available inside 
FLStudio (F1) and on line at 
http://www.FLStudio.com. 
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